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요약



여러분만의안드로이드애플리케이션을작성하기위해필요한것은안드로이드 SDK와

자바개발킷J̀DK, Java Development Kit 한벌이전부다. 여러분이마조히스트masochist가아닌이

상은대개개발을좀더쉽게해주는자바 IDE(특히, 이클립스가괜찮다)를원할것이다.

안드로이드 SDK와자바그리고이클립스는윈도우, 맥OS, 리눅스를위한버전이모두

마련되어있으므로, 여러분이선호하는OS에서편안하게안드로이드를살펴볼수있다. 안

드로이드 SDK는이세가지OS 환경모두를위한에뮬레이터를가지고있으며, 안드로이

드애플리케이션은가상머신위에서실행되기때문에, 어떤특정운영체제로부터오는개

발상의이점은없다고보는것이좋다.

안드로이드코드는자바문법으로작성되며, 코어안드로이드라이브러리는코어자바

API가가진기능의대부분을포함한다. 하지만이들이실행될수있기전에, 여러분의프로

젝트는먼저Dalvik 바이트코드b̀yte code로번역된다. 결과적으로여러분은자바를사용한

다는이점과동시에, 여러분의애플리케이션이안드로이드장치에최적화된가상머신위

에서실행되는이점을얻는다.

안드로이드 SDK에는안드로이드라이브러리와풍부한문서그리고뛰어난샘플애플리

케이션이포함되어있다. 또한 SDK는여러분의프로젝트를실행하기위한안드로이드에

뮬레이터와디버그를돕는Dalvik 디버그모니터링서비스D̀DMS, Dalvik Debug Monitoring Service

같이, 애플리케이션을작성하고디버그하기위한도구역시포함하고있다.

이번장에서는안드로이드 SDK를다운로드받아개발환경을구축하고, 두가지새로운

애플리케이션을완성해, 이를에뮬레이터와DDMS로실행하고디버그해볼것이다.

만일여러분이모바일장치에서동작하는소프트웨어를개발해본경험이있다면, 모바일

장치의작은크기와제한된전력그리고한정된메모리가만들어내는독특한몇가지설계

상의어려움에대해이미잘알것이다. 여러분이이분야에경험이없다손치더라도, 데스

크톱이나웹에서는당연한것들이모바일에서는일부그럴수없다는사실은불을보듯뻔

한일이다.

이러한하드웨어의한계와더불어사용자환경역시나름의어려운도전거리를가져다

준다. 모바일장치는이동하면서사용될뿐만아니라, 집중하기어려운산만한환경에서사

용되는것이보통이므로, 여러분의애플리케이션은빠르고반응성이좋아야하며사용하기

에도편리해야한다.

이렇듯타고난하드웨어의어려움과환경적인요인을극복하도록돕기위해, 이번장에

서는모바일애플리케이션작성을위한베스트프랙티스b̀est practices 몇가지를살펴본다. 전

체주제를붙잡고씨름하려하기보다는, 좋은모바일설계원칙에부합하는측면에서바라

본안드로이드 SDK 사용에초점을맞출것이다.
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안드로이드 SDK는매력적이면서도강력한모바일애플리케이션을작성하는데필요한

모든도구와API를가지고있다. 여느새로운개발툴킷과마찬가지로, 안드로이드의가장

큰난제는바로안드로이드가가진API의특징과한계를배우는것이다.

만일여러분이자바로개발해본경험이있다면, 비록몇몇특유의최적화기법이직관적

이지않아보일지는모르지만, 지금껏사용해온기법과구문그리고문법이안드로이드에

고스란히녹아있음을알게될것이다.

자바에는경험이없지만다른객체지향언어(C# 같은)를사용해본적이있다면, 쉽게안

드로이드로넘어올수있음이느껴져야한다. 안드로이드의힘은그가가진 API로부터오

는것이지자바로부터오는것이아니므로, 자바클래스에익숙지않다고해서큰불이익이

되는것은아니다.

준비물
안드로이드애플리케이션은Dalvik 가상머신에서실행되므로, 안드로이드개발자도구

를지원하는플랫폼이라면어디서든안드로이드애플리케이션을작성할수있다. 현재지

원되는플랫폼은다음과같다.

마이크로소프트윈도우(XP 또는비스타)

맥OS 10.4.8 이상(인텔칩만)

리눅스

안드로이드애플리케이션을작성하기위해서는다음의것들을다운로드받아설치해야

한다.

안드로이드 SDK

자바개발킷(JDK) 5나 6

최신 JDK는아래주소의썬S̀un 홈페이지에서다운로드받을수있다.

http://java.sun.com/javase/downloads/index.jsp
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JDK가 이미 설치되어 있다면, 위에 나열된 버전 요구사항을 만족하는지 확인하기 바란다. 자바 런타임

환경J̀RE, Java Runtime Environment만으로는부족하다는사실을기억하자.

SDK 설치하기

안드로이드 SDK는완전히열려있다. API를다운로드받아사용하는데아무런비용이

들지않으며, 여러분이만든프로그램을배포할때에도구글은이에대해어떠한비용도부

과하지않는다. 여러분의개발플랫폼을위한 SDK 최신버전은아래주소의안드로이드

개발자홈페이지에서다운로드받을수있다.

http://developer.android.com/sdk

달리표시해두지않는한, 이책을쓰는데사용된안드로이드SDK 버전은 1.0 r1이다.❶

안드로이드 SDK는API 라이브러리, 개발자도구, 문서, 그리고여러샘플애플리케이션

과함께특정API 기능의사용을조명하는API 데모를한데담은ZIP 파일로제공된다. 이

압축파일을원하는폴더에푸는것으로 SDK 설치가완료된다(이폴더의위치는나중에필

요하니적어두자).

안드로이드 SDK가제공하는예제와단계별지침은안드로이드개발자도구ÀDT, Android

Developer Tool 플러그인이설치된이클립스를사용하는개발자를대상으로하고있다. 하지

만반드시이들을사용해야하는것은아니다. 여러분의입맛에맞는텍스트에디터나자바

IDE를사용할수있으며, SDK에있는개발자도구를사용해코드와샘플애플리케이션을

컴파일, 테스트, 디버그할수있다.

만일이클립스와 ADT 플러그인을여러분의안드로이드개발환경으로사용할계획이

라면, 다음절에설명된설정방법을참고하자. 이번장후반부에서는 SDK에포함된개발

자도구역시자세히살펴볼것이므로, 이클립스나 ADT 플러그인을사용하지않고개발

하고자하는경우에는이부분을참고하자.

안드로이드 SDK에포함되어있는예제는완전히기능하는안드로이드애플리케이션으로서, 문서화또한

잘되어있다. 개발환경설정을마친뒤한번쯤살펴보는것도도움이될것이다.
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이클립스로개발하기

안드로이드개발환경으로서이클립스와 ADT 플러그인의조합은몇가지커다란이점

을가져다준다.

이클립스Èclipse는특히자바개발진영에서널리사용되고있는오픈소스 IDE(Integrated

Development Environment통합개발환경)다. 이클립스재단Èclipse foundation 홈페이지를통해다

운로드받을수있으며, 안드로이드가지원하는모든개발플랫폼(윈도우, 맥OS, 리눅스)에서

사용할수있다.

http://www.eclipse.org/downloads

위페이지에가보면다운로드받을수있는이클립스의종류가매우다양한데, 이가운데

안드로이드를위한권장구성은다음과같다.

이클립스 3.3, 3.4(Ganymede)❷

이클립스 JDT 플러그인

WST

WST와 JDT 플러그인은대부분의이클립스 IDE 패키지에포함되어있다.

다운로드받은압축파일을원하는폴더에푸는것으로이클립스설치가완료된다. 설치

를완료했으면 Eclipse실행파일을실행하자. 이클립스를처음실행하는경우에는, 안드로

이드개발을위한새로운워크스페이스ẁorkspace 하나를만들자.

이클립스플러그인사용하기

ADT 이클립스 플러그 인은 에뮬레이터와 .class-to-.dex 변환기 등의 개발자 도구를

IDE에직접통합함으로써안드로이드개발을단순화한다. 반드시 ADT 플러그인을사용

해야하는것은아니지만, ADT 플러그인은여러분의애플리케이션을보다빠르고손쉽게

만들어테스트하고디버그할수있게해준다.

ADT 플러그인은다음과같은것들을이클립스에통합한다.
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새로운프로젝트생성을단순화하며기본적인애플리케이션 템플릿을가지고있는

안드로이드프로젝트마법사Àndroid Project Wizard

XML 리소스의 생성, 편집, 검증을 돕는 폼 기반의 매니페스트m̀anifest와 레이아웃
layout 그리고리소스에디터

안드로이드프로젝트의자동화된빌드, 안드로이드실행파일(.dex)로의변환, 패키

지파일(.apk)로의패키징, 그리고Dalvik 가상머신에패키지설치

에뮬레이터의겉모양과네트워크연결설정을제어하고, 걸려오는전화와 SMS 메시

지를시뮬레이션할수있는기능을갖춘안드로이드에뮬레이터

포트포워딩p̀ort forwarding, 스택, 힙, 스레드뷰, 프로세스세부사항, 화면캡쳐기능을

가진Dalvik 디버그모니터링서비스D̀DMS, Dalvik Debug Monitoring Service

폴더 트리를 탐색하고 파일 전송을 가능케 하는 장치나 에뮬레이터의 파일시스템

접근

브레이크포인트b̀reakpoints를설정하고호출스택을볼수있게끔해주는런타임디버깅

안드로이드/Dalvik의모든로그와콘솔출력

그림 2-1은ADT 플러그인이설치된이클립스에서DDMS 퍼스펙티브p̀erspective를보인

모습이다.

그림 2-1
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ADT 플러그인설치하기

아래의단계를따라개발자도구플러그인을설치하자.

1. 이클립스에서Help → Software Updates → Find and Install...을선택한다.

2. 다이얼로그박스가화면에나타나면 Search for new features to install설치할 새로운 기능

검색을선택한다.

3. New Remote Site새 원격 사이트를선택한뒤, 그림 2-2와같이다이얼로그박스안에아

래의주소를입력한다.

https://dl-ssl.google.com/android/eclipse/❸

4. 입력한새로운사이트를체크하고Finish를클릭한다.

5. 이제이클립스가 ADT 플러그인을다운로드할것이다. 다운로드가끝나면나타나는

Search Results검색결과 다이얼로그박스에서 Android Plugin → Developer Tools를

선택하고Next를클릭한다.

그림 2-2
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6. 라이선스계약조건을살펴보고승인한뒤Next와Finish를차례로클릭한다. ADT 플

러그인은서명되어있지않으므로설치진행전이에대한메시지가표시될것이다.

7. 작업이완료되면이클립스를재시작하고 ADT 설정을업데이트해야한다. 이클립스

를 재시작한 뒤 Window → Preferences... (맥 OS의 경우에는 Eclipse →

Preferences)를선택한다.

8. 그런다음왼쪽패널에서Android를선택한다.

9. 그림 2-3에서보이는것처럼, Browse...를클릭해압축을풀어놓은안드로이드 SDK

폴더를찾은다음Apply와OK를클릭한다.

새로운버전의 SDK를다운로드받아이를다른위치에두는경우에는, 이 설정을업데이트해어떤 ADT

가빌드에사용되어야하는지를SDK에반영할필요가있다.

그림 2-3

플러그인업데이트하기

안드로이드 SDK가발전해나감에따라ADT 플러그인의업데이트또한잦아질것이다.

여러분이설치한플러그인을업데이트하는방법은대부분아래와같이간단히이뤄진다.

1. Help → Software Updates → Find and Install...을클릭한다.

2. Search for updates of the currently installed features현재 설치된 기능의 업데이트 검색를선

택하고 Finish...를클릭한다.
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3. 적용할수있는 ADT 업데이트가존재하면화면에나타날것이다. 이가운데원하는

것을선택하고 Ìnstall을클릭한다.

때로는이러한동적업데이트메커니즘을사용할수없을만큼플러그인업그레이드가

중요한경우도있다. 이럴때는앞절에서설명한대로새로운버전을설치하기에앞서이

전플러그인을완전히제거해야만할것이다.❹

첫번째안드로이드액티비티만들기
SDK를다운로드받았고이클립스와플러그인도설치했다. 이제안드로이드프로그래밍

을시작할준비가됐다. 먼저새로운프로젝트하나를생성한다음, 이클립스의실행및디

버그구성을설정하는것으로시작하자.

새로운안드로이드프로젝트시작하기

새안드로이드프로젝트마법사를통해새로운안드로이드프로젝트를만드는방법은아

래와같다.

1. File → New → Project를선택한다.

2. Android폴더에서애플리케이션타입을Android Project로선택하고Finish를클릭한

다.

3. 화면에나타나는다이얼로그(그림 2-4)에새로운프로젝트에관한세부사항을입력한

다.“Project name”에는 프로젝트 파일 이름을,“Package name”에는 프로젝트의

패키지를,“Activity name”에는초기액티비티클래스이름을,“Application name”

에는맘에드는애플리케이션이름을입력하자.

4. 세부사항을입력하고난뒤Finish를클릭한다.
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역주 ❹ 안드로이드 SDK 1.5 r1이 발표되면서 그에 따라 ADT 플러그 인도 업데이트되었다. 안드로이드 SDK 1.5 r1을
사용하고자 한다면, 기존에 설치된 ADT 플러그 인을 제거한 뒤“ADT 플러그 인 설치하기”에 나열된 절차를 따
라 ADT 플러그 인을 새로운 버전으로 다시 설치하면 된다.



그림 2-4

이렇게하고나면ADT 플러그인은 Activity를확장하는새로운클래스가포함된프로

젝트하나를생성한다. 이기본템플릿은아무것도없이텅비어있지않고“Hello World.”

를구현한다. 이프로젝트를수정하기에앞서이를가지고실행및디버그시작구성을만

들어보자.

시작구성만들기

시작구성l̀aunch configurations은애플리케이션의실행및디버깅을위한런타임옵션을지

정하도록해준다. 시작구성을통해지정할수있는사항에는아래와같은것들이있다.

띄울프로젝트와액티비티

사용할에뮬레이터옵션

입/출력설정(콘솔기본값포함)

여러분은실행모드와디버그모드에대해서로다른시작구성을지정할수있다. 다음

절차는안드로이드애플리케이션의시작구성생성방법을보여준다.
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1. Run → Open Run Dialog... (또는Run → Open Debug Dialog...)를선택한다.

2. 타입목록에서Android Application을오른쪽마우스버튼으로클릭하고New를선택

한다.

3. 이구성의이름을입력한다. 프로젝트마다복수의구성을만들수있으므로, 해당구

성이어떤설정을담고있는지를쉽게알수있도록적당한이름을붙이자.

4. 이제시작옵션을고른다. 첫번째탭(Android)에서는애플리케이션을실행(또는디버

그)할때시작시킬프로젝트와액티비티를선택할수있다. 그림 2-5는앞서여러분이

만든프로젝트를위한설정사항을보여준다.

그림 2-5

5. Target탭으로이동해에뮬레이터를구성한다. 이탭에는화면크기와장치스킨그리

고네트워크연결설정을고를수있는옵션이있다. 또한에뮬레이터상에있는사용

자데이터를임의로지울수있으며, 부트애니메이션을활성화하거나비활성화할수

있다. 필요하다면명령행c̀ommand-line 텍스트박스를사용해추가적인에뮬레이터시작

옵션을지정할수도있다.

6. 마지막으로, Common탭에서기타추가속성을설정한다.

7. Apply를클릭하면, 여러분의시작구성이저장된다.

안드로이드애플리케이션실행및디버깅

이렇게해서여러분의첫번째프로젝트와이를위한실행및디버그구성을만들었다.

그럼Hello World 프로젝트를실행하고디버깅하여설치와구성을테스트해보자.

Run 메뉴에서 Run이나 Debug를 선택해 가장 최근에 선택된 구성을 띄우거나, Open

Run Dialog...또는Open Debug Dialog...를선택해사용할구성을선택한다.
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ADT 플러그인을사용하고있는경우, 애플리케이션을실행하거나디버깅하는과정은

다음과같다.

현재프로젝트를컴파일한뒤이를안드로이드실행이미지(.dex)로변환한다.

실행이미지와외부리소스를안드로이드패키지(.apk)로묶는다.

에뮬레이터를시작시킨다(이미실행중인상태가아닐경우).

애플리케이션을에뮬레이터에설치한다.

애플리케이션을시작시킨다.

디버깅중인경우에는브레이크포인트를설정해코드를디버그할수있는이클립스디버

거d̀ebugger가부착된다.

모든것이올바르게동작한다면, 그림 2-6과같이에뮬레이터에서실행중인새로운액

티비티하나를보게될것이다.❺

그림 2-6

38

professional Android Application Development

시작하기02
chapter

역주 ❺ 안드로이드 SDK 1.5 r1를 사용하고 있다면, 그림 2-6과 같은 결과 대신“Failed to find an AVD compatible
with target ‘Android 1.5’. Launch aborted.”라는 에러를 만나게 될 것이다. 이는 실제 장치를 보다 잘 모델링
할 수 있도록 하기 위해, 안드로이드 SDK 1.5 r1을 시작으로 안드로이드 가상 장치ÀVD, Android Virtual Devices라는 개
념이 도입됐기 때문이다. 명령행(윈도우의 경우에는 명령 프롬프트를 실행한다)에서 아래의 명령을 사용해 AVD를
하나 만들도록 하자. AVD에 대한 보다 자세한 내용은 http://developer.android.com/guide/developing/
tools/avd.html을 참고하자.

android create avd --name TestAVD_1.5 --target 2



헬로월드이해하기

잘동작하는것을확인했으니, 한발뒤로물러나여러분의첫번째안드로이드애플리케

이션의실제모습을살펴보자.

Activity는애플리케이션의비주얼한구성요소와인터랙티브한구성요소를위한기반

클래스로서, 전통적인데스크톱개발에서의폼F̀orm과얼추같다고할수있다. 아래에있는

코드는 Activity에 기반을 둔 클래스의 골격을 보여준다. Activity를 확장하고 있으며,

onCreate메서드를재정의하고있음을눈여겨보자.

package com.paad.helloworld;

import android.app.Activity;

import android.os.Bundle;

public class HelloWorld extends Activity {

/** 액티비티가 처음 생성될 때 호출된다. */

@Override

public void onCreate(Bundle icicle) {

super.onCreate(icicle);

}

}

이템플릿에는비주얼인터페이스의레이아웃이빠져있다. 비주얼한구성요소를안드로

이드에서는뷰v̀iews라하는데, 이는전통적인데스크톱개발에서의컨트롤controls과유사하다.

마법사가생성한 Hello World 템플릿에는, 아래에강조된것처럼 onCreate 메서드가

setContentView를 호출하도록 재정의되어 있다. setContentView는 레이아웃 리소스를

부풀려유저인터페이스를배치한다.

@Override

public void onCreate(Bundle icicle) {

super.onCreate(icicle);

setContentView(R.layout.main);

}

안드로이드프로젝트의리소스는프로젝트계층의 res라는폴더안에저장되는데, 이폴

더는 drawable, layout, values라는하위폴더를포함하고있다. ADT 플러그인은이들

XML 리소스를해석하여, R이라는변수를통해설계시점에이들을접근할수있도록하는

데, 이에대해서는 3장에서설명한다.
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아래에있는코드는안드로이드프로젝트템플릿이생성한 main.xml 파일에정의된UI

레이아웃을보여준다.

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent">

<TextView

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="Hello World, HelloWorld"

/>

</LinearLayout>

UI를XML로정의한뒤이를부풀리는방식은UI 디자인에서애플리케이션로직을깔끔

하게분리해내기때문에사용자인터페이스구현시선호된다.

코드내에서 UI 엘리먼트에접근하려면, 해당하는 UI 엘리먼트의 XML 정의에식별자
ìdentifier 속성을추가해야한다. 이렇게하면이름이주어진각아이템의레퍼런스를리턴

하는 findViewById 메서드를사용할수있다. 아래에있는 XML 코드는Hello World 템

플릿의TextView 위젯에추가된 ID 속성을보여준다.

<TextView

android:id="@+id/myTextView"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="Hello World, HelloWorld"

/>

그리고아래에있는코드는이를코드에서접근하는방법을보여준다.

TextView myTextView = (TextView)findViewById(R.id.myTextView);

필요하다면여러분의레이아웃을다음와같이직접코드로생성할수도있다(하지만그

리좋은방법은아니다).
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public void onCreate(Bundle icicle) {

super.onCreate(icicle);

LinearLayout.LayoutParams lp;

lp = new LinearLayout.LayoutParams(LayoutParams.FILL_PARENT,

LayoutParams.FILL_PARENT);

LinearLayout.LayoutParams textViewLP;

textViewLP = new LinearLayout.LayoutParams(LayoutParams.FILL_PARENT,

LayoutParams.WRAP_CONTENT);

LinearLayout ll = new LinearLayout(this);

ll.setOrientation(LinearLayout.VERTICAL);

TextView myTextView = new TextView(this);

myTextView.setText("Hello World, HelloWorld");

ll.addView(myTextView, textViewLP);

this.addContentView(ll, lp);

}

코드에서사용가능한모든프로퍼티는XML 레이아웃내에서속성으로설정될수있다.

이렇게하면레이아웃디자인과개별적인 UI 엘리먼트를보다손쉽게바꿀수있을뿐만

아니라, 비주얼디자인을애플리케이션과분리함으로써코드를보다간결하게유지할수

있다.

안드로이드 웹 사이트(http://developer.android.com/guide/index.html)에는 여러분이 안드로

이드개발자로서사용하게될많은기능과좋은습관을설명하는훌륭한단계별지침몇가지가포함되어

있다. 따라하기쉽게구성되어있으며, 안드로이드애플리케이션이어떻게하면서로잘맞을수있을지에

대한좋은아이디어를담고있으므로한번쯤살펴보길권한다.

안드로이드애플리케이션의종류
여러분이만드는안드로이드애플리케이션의대부분은아래에나열된범주중하나에속

할것이다.

포그라운드 액티비티f̀oreground activity 포그라운드에있을때만쓸모있는애플리케이

션으로서, 화면에보이지않을때는사실상일시중단된다. 게임과맵매시업m̀ashups

이이부류에속하는대표적인예다.
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백그라운드 서비스b̀ackground service 구성이변경되고있는경우를제외한대부분의

시간을화면에보이지않은채로실행되는상호작용이제한된애플리케이션. 전화차

단애플리케이션이나 SMS 자동응답기가이부류에속한다.

인터미턴트 액티비티ìntermittent activity 드문드문상호작용이있긴하지만대부분의작업

을백그라운드에서수행한다. 이런류의애플리케이션을실행하면보통소리소문없이

동작하다가적절한때에사용자에게통지한다. 미디어플레이어가대표적인예다.

복잡한애플리케이션은하나의범주로분류해넣기어려우며, 이세가지가가진요소를

모두포함한다. 애플리케이션을만들때는용도를고려하여그에맞게설계할필요가있다.

그럼위에설명된애플리케이션종류각각에대한몇가지설계고려사항에대해자세히살

펴보자.

포그라운드액티비티

포그라운드애플리케이션을만들때는액티비티가포그라운드와백그라운드사이를매

끄럽게넘나들수있도록액티비티수명주기(3장에서설명한다)를신중히고려할필요가

있다.

자신의수명주기를제어할수없는애플리케이션과, 서비스를제외한기타백그라운드

로전환된애플리케이션은안드로이드의리소스관리를통해정리되는후보일순위다. 이

는액티비티가화면에서사라질때애플리케이션상태를저장해두고, 포그라운드로돌아올

때전과똑같은상태로나타날필요가있음을의미한다.

깔끔하고직관적인사용자경험ùser experience을선보이는것역시포그라운드액티비티에

게는중요하다.

단정하면서도매력적인포그라운드액티비티를만드는방법에대해서는 3장에서보다

자세히배울것이다.

백그라운드서비스

이부류에속한애플리케이션은매우드문사용자입력을가지고백그라운드에서조용히

실행된다. 사용자의상호작용보다는대개하드웨어나시스템또는다른애플리케이션이만

들어낸메시지나액션에귀기울인다.

화면에전혀보이지않는형태의서비스를만들수있긴하지만, 실제로는사용자가제어

할수있는몇가지종류의기능을제공하는형태가더낫다. 최소한서비스가현재실행중

인지정도는사용자가확인할수있어야하며, 필요에따라구성을바꾼다거나일시중지
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또는종료할수있게끔해야한다.

백그라운드애플리케이션의발전소인서비스에대해서는 8장에서자세히다룬다.

인터미턴트액티비티

때로는사용자의입력에반응하면서도활성화된포그라운드액티비티가아닐때역시여

전히쓸모있는애플리케이션을만들고자할수있다. 이런애플리케이션은보통화면에보

이지않는백그라운드서비스와이를제어하기위한화면에보이는컨트롤러액티비티가

결합한형태를띤다.

이부류에속한애플리케이션은사용자와상호작용할때자신의상태를인식할필요가

있다. 이는자신이화면에나타날때액티비티 UI를업데이트하는것과, 백그라운드에있

을때사용자가업데이트된상태를유지하도록알림ǹotifications을전송하는것을의미하는

것일수있는데, 이에대해서는 8장의알림과서비스절에서자세히다룬다.

안드로이드가모바일소프트웨어개발을단순화하는많은일을하고있지만, 이러한약

정이면에있는갖가지이유를이해하는것은여전히중요하다. 모바일및임베디드장치를

위한소프트웨어를작성할때, 특히안드로이드애플리케이션을개발할때감안해야하는

많은요인이존재한다.

이번 장에서는 효율적인 안드로이드 코드를 작성하기 위한 몇 가지 기법과 베스트 프랙티스를 배울 것이

다. 이후예제에서는안드로이드의새로운개념이나기능을소개할때명확함과간결함을위해서이따금씩

효율성을절충하기도하는데, 이예제들은무언가를하는가장간단한(혹은가장이해하기쉬운) 방법을보

여주도록의도된것이므로, 이를통해제시되는방법이항상최선은아님을염두에둬야한다. “내가‘바담

풍’해도너는‘바람풍’해라”라는옛속담을기억하기바란다.

하드웨어를고려한설계
작고휴대가능한모바일장치는흥미진진한소프트웨어개발기회를제공한다. 이들이

가진제한된화면크기를비롯한적은메모리와저장공간그리고프로세서속도는흥미가

훨씬덜하지만, 대신몇가지독특한도전과제를선사한다.
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데스크톱이나노트북컴퓨터와비교해볼때모바일장치는다음과같은특징을갖는다.

느린처리속도

제한된RAM

제한된영구저장공간

저해상도의작은화면

비싼데이터전송비용

다소신뢰성이떨어지는데이터연결

제한된배터리수명

새로운애플리케이션을만들때는이러한제한사항을마음에새기는것이중요하다.

효율적일것

임베디드장치, 특히모바일장치제조사는프로세서속도의잠재적인개선보다는작은

크기와긴배터리수명에더가치를둔다. 개발자의입장에서볼때, 이는곧무어의법칙으

로인해주어지던유리한출발점을잃는다는것을의미한다. 해마다보게되는데스크톱과

서버하드웨어의성능향상은모바일의경우대개프로세서의큰속도향상보다는좋은전

력효율로재표현된다.

실제로이는여러분이항상코드를빠르고반응성이좋게끔최적화해야함과동시에, 여

러분의소프트웨어가사용되는동안하드웨어향상의이득을볼수없다고가정할필요가

있음을의미한다.

코드의효율성에관한부분은소프트웨어공학에서도굉장히큰주제에속하므로, 섣불

리여기서다루려하지는않겠다. 비록이번장에서는안드로이드에특화된몇가지효율성

에관한팁만을다루지만, 효율성이라는것은모바일장치처럼리소스가한정된환경에서

특히중요하다는사실을기억하자.

제한된저장공간을예측할것

플래시메모리와반도체디스크S̀SD, Solid-State Disk ❻의발전은모바일장치가가진저장능
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력의극적인증대를이끌어왔다(늘어난저장공간은금새다시MP3로가득채워지는경향이

있긴하지만). 하지만실제로대부분의장치가여전히여러분의애플리케이션에상대적으

로제한된저장공간을제공한다. 애플리케이션의컴파일된크기도중요하지만, 애플리케이

션이시스템리소스를품위있게사용하도록만드는것이보다중요하다.

여러분은애플리케이션이데이터를저장하는방법에대해신중히고려해야한다. 안드로

이드데이터베이스와콘텐트공급자를사용하면대량의데이터를편리하게저장, 재사용,

공유할수있는데, 이에대해서는 6장에서설명한다. 환경설정이나상태설정과같은작은

데이터저장을위해서도안드로이드는최적화된프레임워크를제공하는데, 이역시 6장에

서살펴본다.

물론이들메커니즘을사용하지않고직접파일시스템에기록하고자하거나그럴필요가

있는경우에는그렇게할수있는데, 이런상황에서는항상파일을구조화하는방법에대해

고려해야하며, 여러분이선택한방법이과연효율적인해결책인지를확실히해야한다.

리소스를품위있게사용하는방법가운데하나는, 사용하고난리소스를여러분이직접

해제하는것이다. 캐싱c̀aching 같은기법은반복되는네트워크조회를제한하는데유용하지

만, 더이상필요치않을때는파일시스템상에파일이나데이터베이스에레코드를남겨두

지않는다.

작은화면을위해디자인할것

휴대폰의작은크기와휴대할수있다는특징은좋은인터페이스를만드는데걸림돌이

되는데, 이는사용자가점점더멋지고정보가풍부한그래픽사용자경험을요구할때특

히더그렇다.

사용자는 (작은) 화면을종종흘끗보기만한다는사실을염두에두고애플리케이션을작

성하자. 컨트롤개수를줄이고가장중요한정보를맨앞한가운데둠으로써애플리케이션

을직관적이고사용하기쉽게만들자.

여러분이 4장에서만들게될것과같은그래픽컨트롤은빽빽한정보를이해하기쉽게

전하는훌륭한수단이다. 버튼과텍스트입력박스로가득찬화면대신, 색상과모양그리

고그래픽스를사용해정보를나타내자.

만일 터치 스크린을 지원할 계획이라면(생각해보지 않았다면 지금 계획에 넣도록 하자),

터치입력이여러분의인터페이스디자인에어떠한영향을미치게될지고려할필요가있

을것이다. 스타일러스s̀tylus❼의시대는지났다. 이제는모든것을손가락으로하는것이대
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세이므로, 화면을손가락으로조작할수있게끔뷰를충분히크게만들자. 터치스크린상

호작용에대한보다많은정보는 11장에서다룬다.

물론, 휴대폰의해상도와화면크기가점점커지는추세이므로, 작은화면을위해디자인

하되UI의크기가조절될수있도록하는것이현명하다.

느린속도와긴지연시간을예측할것

5장에서는애플리케이션에서인터넷리소스를사용하는방법을배울것이다. 풍부한온

라인정보를애플리케이션에통합하는능력은믿을수없으리만큼강력하다.

불행히도모바일웹은우리가바라는만큼빠르거나신뢰적이지않으며쉽게사용가능

하지도않으므로, 인터넷기반애플리케이션을개발할때는네트워크연결이느리고, 간헐

적이며, 요금또한비싸다고가정하는편이최선이다. 이러한상황은 3G 무제한정액요금

제및사방에설치된Wi-Fi와함께변해가고있지만, 최악의경우를대비해설계하게되면

언제나높은기준의사용자경험을전해줄수가있다.

이는또한여러분의애플리케이션이끊긴(혹은아직찾지못한) 데이터연결을다룰수있

어야함을의미한다.

안드로이드에뮬레이터는이클립스시작구성설정시네트워크연결속도와지연시간

을제어할수있도록해준다. 그림 2-7은차선次̀善으로사용될 EDGE 연결을시뮬레이션하

기위한에뮬레이터의네트워크연결속도와지연시간설정을보여준다.

그림 2-7

사용가능한네트워크는무엇이고속도와지연시간은어떻게되는지에관계없이좋은

반응성을유지하도록테스트하자. 어떤상황에서는사용할수있는네트워크에따라애플

리케이션기능을제한하거나캐시된데이터에대한네트워크조회를줄이는편이더낫다
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는것을발견할지도모른다. 실행중에사용가능한네트워크연결의종류와속도를감지하

는방법에대해서는 10장에서다룬다.

비용은얼마나?

모바일장치를하나쯤가지고있다면너무나잘알겠지만, 모바일장치가가진강력한기

능중일부는사실상비용을지불해야사용할수있다. SMS, GPS, 그리고데이터전송같

은서비스를사용하려면서비스공급자에게추가요금을내야한다.

애플리케이션에있는기능과연관된모든비용을최소화하는것과, 사용자가자신이수

행하는동작에비용이부과될수있음을아는것이왜중요한지는명백하다.

바깥세상과의상호작용을수반하는모든동작에는그에따른비용이존재한다고가정하

는것이좋다. 아래의방법을통해상호작용비용을최소화하자.

가능한한데이터전송을작게하기

데이터와GPS 결과를캐싱해중복또는반복참조제거하기

액티비티가포그라운드에서화면에보이지않을때, 데이터전송및GPS 업데이트가

UI를업데이트하는데에만사용되고있다면이를모두중단하기

데이터전송(그리고위치조회)을위한재생/갱신비율을실질적인최저수준으로유

지하기

큰업데이트나전송은 8장에소개된것처럼알람을이용해“한산할때”수행하도록

계획하기

가끔은비용이적게드는낮은품질옵션을사용하는것이최선의해결책이기도하다.

7장에설명된위치기반서비스를사용할때는관련된비용이존재하는지에따라위치공

급자l̀ocation provider를선택할수있다. 위치기반애플리케이션을만들때는사용자가저렴한

요금과높은정확도사이를선택할수있도록배려하자.

어떤상황에서는비용을정의하기가어렵거나사용자마다상이하기도하다. 서비스요금

은서비스공급자와사용자계획에따라천차만별이다. 무제한무료데이터전송을사용하

는사람들이있는가하면, 무료 SMS를사용하는사람들도있다.

저렴해보이는특정서비스하나를강요하기보다는이를사용자가직접고를수있도록

하자. 예컨대, 인터넷을통해데이터를다운로드받을경우, 어떤네트워크든사용가능한

것하나를골라사용할것인지아니면Wi-Fi를통해연결됐을때만전송하도록제한할것

인지를사용자에게물을수있다.
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사용자환경고려하기
사용자가자신의폰에있는기능중여러분의애플리케이션을가장중요한것으로여기

리라생각하고있다면큰오산이다.

일반적으로휴대폰의첫째가는주요한기능은전화이고, 둘째는 SMS와이메일커뮤니케

이터이며, 셋째는카메라이고, 넷째는 MP3 플레이어다. 여러분이작성하는애플리케이션

은필시“유용한모바일도구”라는다섯번째부류에속할것이다.

그렇다고이게나쁘다는말은아니다. 구글맵과웹브라우저등훌륭한다른애플리케이

션역시사정은마찬가지다. 이런점을감안한다면사용자의휴대폰사용모델은달라지게

될것이다. 어떤사람들은자신의휴대폰을절대음악감상용으로사용하지않으며, 또일

부휴대폰은카메라를가지고있지않지만, 장치에없어서는안될만큼흔히내제되어있

는멀티태스킹m̀ultitasking 원리는사용성설계를위한중요한고려사항이다.

사용자가여러분의애플리케이션을언제그리고어떻게사용할지고려하는것또한중요

하다. 사람들은기차를타거나길을걸을때심지어운전중에도항상휴대폰을사용한다.

여러분은사람들이자신의폰을적절히사용하도록만들수는없지만, 여러분의애플리케

이션을필요이상으로혼란스럽지않게만들수는있다.

소프트웨어설계의입장에서볼때이는무엇을의미할까? 애플리케이션을만들때는아

래와같은내용을염두에두자.

상황에 따라 효율적으로 동작해야 한다. 액티비티가포그라운드에있지않을때는일

시중단된상태로시작하도록하자. 안드로이드는액티비티가일시중단되거나다시

복구되어실행을계속할경우이벤트핸들러를호출하므로, 애플리케이션이화면에

보이지않을때여러분은 UI 업데이트와네트워크조회를잠시멈출수있다(애플리

케이션이화면에보이지않을때 UI를업데이트하는것은별의미가없다). 백그라운드

에서업데이트나처리를계속해야할필요가있는경우를위해, 안드로이드는 UI 오

버헤드없이백그라운드에서실행되도록설계된서비스클래스를제공한다.

백그라운드에서 포그라운드로 매끄럽게 전환되어야 한다. 모바일장치의멀티태스킹특

성으로인해, 여러분의애플리케이션은십중팔구규칙적으로백그라운드로전환되었

다가빠져나올가능성이높다. 이렇게될경우에는빠르고매끄럽게“되살아나는것”

이중요하다. 안드로이드의비결정적프로세스관리ǹondeterministic process management는

여러분의애플리케이션이백그라운드에있을경우리소스회수를위해종료될수있

음을의미한다. 이것이사용자의눈에보여서는안된다. 이는사용자가여러분의애

플리케이션을재시작하는것과다시복구되어실행을계속하는것간의차이를알아
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차리지못하도록애플리케이션상태를저장하고업데이트된내용을대기열에넣음으

로써보장할수있다. 원상태로되돌아오는전환은사용자가마지막으로봤던동일한

UI와애플리케이션상태를보이도록매끄러워야한다.

품위 있어야 한다. 여러분의애플리케이션은절대로사용자가현재사용하고있는

액티비티의 포커스를 빼앗거나 방해해서는 안 된다. 애플리케이션이 포그라운드에

있지않을때는, 뭔가를알리거나상기시키는방법으로사용자의주의를끌기보다는

알림Ǹotifications과토스트T̀oasts(8장에서자세히다룬다)를사용하자. 모바일장치가사

용자에게뭔가를알리는방법에는여러가지가있다. 예컨대, 전화가걸려올경우폰

은벨소리를울리고, 읽지않은메시지가있을경우에는 LED를깜박이며, 신규음성

메일이있을때는상태바에작은“메일”아이콘을나타낸다. 알림메커니즘을사용하

면위에나열한모든기법뿐만아니라그이상의많은것이가능하다.

일관된 사용자 인터페이스를 보여줘야 한다. 여러분의애플리케이션은사용자가늘사

용하는여러애플리케이션가운데하나일가능성이있으므로, 편리한UI를선보이는

것이중요하다. 사용자가애플리케이션을띄울때마다매번이를이해하고다시배우

도록강요하지말자. 애플리케이션은사용이간단하고, 쉽고, 분명해야하는데, 제한

된화면공간과산만한사용자환경속에서는특히더그렇다.

반응성이 좋아야 한다. 반응성은모바일장치에서가장중요한설계고려사항가운데

하나다. 분명여러분은소프트웨어의일부가“얼어버려”꼼짝달싹못하는좌절을경

험해봤을것이다. 모바일이가지는다기능이라는특징은더성가시다. 느리고신뢰성

이떨어지는데이터연결로인해생길수있는지연가능성을염두에두고, 여러분의

액티비티가좋은반응성을유지하도록애플리케이션이작업자스레드ẁorker threads와

백그라운드서비스를사용하는게중요하며, 다른애플리케이션이적시에반응할수

없도록방해하는것들을중단하는것이보다중요하다.

안드로이드애플리케이션개발하기
지금까지는안드로이드에대해구체적으로다루지않았다. 앞서살펴본설계고려사항은

모바일애플리케이션개발시보편적으로적용되는중요한내용이다. 안드로이드는이러한

일반적인지침과더불어추가적인몇가지특별한고려사항을가지고있다.

우선잠시시간을내어 http://code.google.com/android/toolbox/philosophy.html

에있는구글의안드로이드설계철학을읽어보면많은도움이될것이다.

안드로이드설계철학은애플리케이션이다음의사항을만족할것을요구한다.
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빠를것

반응성이좋을것

안전할것

심리스`̀seamless할것

빠르고효율적일것

리소스가한정된환경에서빠르다는것은효율적임을뜻한다. 여러분이이미알고있는

효율적인코드작성에관한많은것들이안드로이드에도유효하겠지만, 임베디드시스템의

한계와Dalvik VM의사용은이를그저당연한것으로여길수만은없음을의미한다.

가장현명한조언은소스를들여다보라는것이다. 안드로이드팀은안드로이드를위한

효율적인코드작성에관한몇가지구체적인지침을발표했다. 이제안을여기에다시고

쳐 옮겨 반복하기보다는, 여러분이 직접 http://code.google.com/android/toolbox/

performance.html을방문해살펴볼것을권한다.

이들 성능 제안 가운데, 가령 내부 세터s̀etters 및 게터g̀etters 사용을 피하라든가, 인터페이스보다는 가상
v̀irtual을 선호하라는등몇가지사항이기존에알고있던설계원칙과모순됨을발견할지모른다. 임베디

드장치와같이리소스가한정된시스템을위한소프트웨어를작성할때는이따금씩정형화된설계원칙

과높은효율성요구간에절충이존재하기마련이다.

효율적인안드로이드코드작성을위한핵심가운데하나는, 데스크톱과서버환경에서

의가정들을임베디드장치로끌어들이지않는것이다.

대부분의데스크톱및서버장비의경우 2GB에서 4GB의메모리를갖는것이보통임에

반해, 최신스마트폰이라할지라도 32MB RAM을갖는것은행운이다. 여러분은이처럼한

정된메모리를효율적으로사용하기위해특별관리가필요하다. 이는스택과힙의사용방

식, 객체생성제한하기, 그리고변수의유효범위가메모리사용에어떠한영향을미치는지

에관해생각하는것을뜻한다.

반응성이좋을것

안드로이드는반응성을매우심각하게받아들인다.

안드로이드는액티비티관리자와윈도우관리자를통해반응성을관리한다. 만일이두

서비스중하나가반응이느린애플리케이션을감지하게되면, 그서비스는그림 2-8과같

이애플리케이션의반응이느림을알리는 AUR(Application unresponsive) 메시지를내

보일것이다.
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그림 2-8

이경보는모달m̀odal로서, 포커스를빼앗으며, 사용자가버튼을누르거나여러분의애플

리케이션이반응을보이기시작할때까지사라지지않을것이다. 이는절대로사용자에게

마주하도록하고싶지않은최후의것이나다름없다.

안드로이드는반응성을결정하기위해다음두가지조건을감시한다.

애플리케이션은키누름이나화면터치같은모든사용자액션에대해반드시 5초이

내로반응해야한다.

브로드캐스트 수신자B̀roadcast Receiver는 자신의 onReceive 핸들러에서 반드시 10초

이내에리턴해야한다.

느린반응성을유발하는가장유력한범인은네트워크조회, 복잡한처리(게임의이동계

산같은), 그리고파일 I/O다.

이들동작이위반응성조건을초과하지않도록보장하는방법에는여러가지가있는데,

이가운데서비스와작업자스레드를사용하는방법은 8장에서다룬다.

사용성의관점에서볼때 AUR 다이얼로그는최후의수단이다. 넉넉해 보이는이 5초 제한은최악의시

나리오이지 목표로 삼아야 할 기준이 아니다. 사용자는 키 누름과 동작 간에 0.5초 이상 넘어가는 모든

버벅거림을알아차릴것이다. 다행히도, 여러분이이미작성하고있는효율적인코드의부수효과는더빠

르고반응성좋은애플리케이션일것이다.

안전한애플리케이션개발하기

안드로이드애플리케이션은하드웨어를직접접근하며, 자유롭게배포될수있고, 또열

린소통이오고가는오픈소스플랫폼위에빌드되므로, 보안이큰관심사인것은어찌보

면당연한일이다.
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사용자가설치하는애플리케이션과여기에부여하는권한에대한책임은대부분의경우

사용자자신이질것이다. 안드로이드보안모델은애플리케이션이어떠한서비스와기능

을사용하기전에그에대한권한을먼저요청하도록함으로써해당서비스와기능에대한

접근을제한한다. 그러면설치하는동안사용자는애플리케이션이요청된권한을부여받아

야 하는지를 결정한다. 안드로이드의 보안 모델에 관해서는 11장과 http://code.

google.com/android/devel/security.html에서보다많이배울수있다.

이것만으로는부족하다. 여러분은안전그자체에관심을가지고애플리케이션을만들어

야할뿐만아니라, 애플리케이션이장치를위협하기위한목적으로약탈될수없도록보장

해야할필요가있다. 장치보안유지를위해사용할수있는기법에는여러가지가있는데,

이들에대해서는그안에수반된기술들을배워나가면서보다자세히다룰것이다. 여러분

은특히아래의내용을염두에둬야한다.

여러분이생성하는모든서비스나전송하는모든브로드캐스트에대해권한요청을

고려하자.

여러분의애플리케이션이인터넷이나 SMS 메시지또는인스턴트메시징(IM) 같은

외부소스로부터입력을받아들일때는각별히주의하자. 애플리케이션메시징을위

한 IM과 SMS 사용에대한보다자세한사항은 9장에서찾아볼수있다.

여러분의애플리케이션이하위수준의하드웨어에대한접근을노출할지모를때는

신중을기하자.

이책에있는많은예제는명확함과간결함을이유로보안에대해상당히완화된접근법을취한다. 여러분

만의애플리케이션을 만드는경우, 특히 배포 계획을가지고있는경우에는이부분을간과해서는안된

다. 안드로이드보안에대한자세한사항은 11장에서찾아볼수있다.

심리스사용자경험보장하기

다소애매모호하긴하지만심리스사용자경험에대한아이디어는중요한개념이다. 심

리스s̀eamless란무슨뜻일까? 심리스의목표는애플리케이션이즉각시작, 종료, 전이되고,

눈에띄는지연이나거슬리는전이가없는일관된사용자경험이다.

모바일장치의속도와반응성이사용자경험을저하해서는안된다. 안드로이드의프로

세스관리는말없는자객刺̀客처럼필요에따라리소스회수를위해백그라운드애플리케이

션을종료시킨다. 여러분의애플리케이션은이점을기억해, 재시작되든아니면다시복구

되어실행을계속하든관계없이항상일관된인터페이스를보여줘야한다.

일반적으로서로다른개발자에의해작성된여러서드파티애플리케이션을실행하는안
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드로이드장치에서는이들애플리케이션간의매끄러운상호작용이특히나중요하다.

사용성에대해서는일관적이면서도직관적인접근법을사용하자. 물론기존과는다른파

격적인애플리케이션을만들수도있지만, 이역시폭넓은안드로이드환경과깔끔하게통

합돼야한다.

애플리케이션이화면에보이지않을때는세션간에데이터를지속하고, 프로세서사이클이

나네트워크대역폭혹은배터리수명을닳게하는작업을일시중단하자. 액티비티가화면에

보이지않는동안에도애플리케이션이계속실행되어야할필요가있는처리를가지고있다면

서비스를이용하되이러한구현결정을사용자에게숨기자.

애플리케이션이뒤에있다가앞으로오거나재시작될때는가장마지막에보였던상태로

매끄럽게되돌아와야한다. 사용자의입장에서각애플리케이션은사용될채비를갖추고

화면밖에서얌전히앉아있어야한다.

또한여러분은알림사용을위한베스트프랙티스가이드라인을따라야하며, 애플리케

이션간의일관성유지를위해일반화된UI 요소와테마를사용해야한다.

이외에도심리스사용자경험을보장하기위해사용할수있는다른많은기법들이존재

하는데, 안드로이드에서할수있는보다많은가능성을발견해나가면서그가운데일부를

이어지는장들을통해만나보게될것이다.

이번예제에서는안드로이드애플리케이션을완전히밑바닥에서부터새로만들어볼것

이다. 이예제는새로운프로젝트를시작하는데수반되는기본적인단계들을설명하기위

한것으로서, 안드로이드가제공하는뷰컨트롤을사용해간단한할일목록t̀o-do list 애플리

케이션을만든다.

이 예제에서 일어나는 일을 다 이해하지 못한다 할지라도 너무 걱정하지 말자. ArrayAdapter,

ListView, KeyListener 등 이애플리케이션을만드는데사용된기능가운데일부는이후의장들을통

해자세히설명될때까지제대로알려주지않을것이다. 또한여러분이안드로이드에대해더많은것을배

워나감에따라이예제로되돌아와서새로운기능을추가할것이다.
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1. 먼저 새로운 안드로이드 프로젝트 하나를 생성한다. 이클립스에서 File → New →

Project...를선택한다음, 그림 2-9에서보이는것처럼Android를선택하고Next를클

릭한다.

그림 2-9

2. 화면에나타나는다이얼로그박스(그림 2-10)에새로운프로젝트에관한세부사항을

입력한다.“Application name”에는맘에드는여러분의애플리케이션이름을입력

하고,“Activity name”에는여러분의액티비티하위클래스이름을입력하자. Finish

를클릭해입력된세부정보를바탕으로새로운프로젝트를생성하자.

그림 2-10
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3. Run → Open Debug Dialog...와 Run → Open Run Dialog...를통해디버그와실행

각각을위한새로운구성을만들고, Todo_List 프로젝트를지정함으로써디버그및

실행구성을설정하자. 시작동작Launch Default Activity로놔두거나, 그림 2-11에서

보이는것처럼새로운 ToDoList액티비티를띄우도록명시적으로설정할수있다.

그림 2-11

4. 이제여러분이사용자에게보여주고싶은것과사용자가수행할필요가있을동작들을

결정한다. 이를위한사용자인터페이스는가능한한직관적으로설계하자.

이예제에서는사용자에게해야할일들의목록과새로운할일을추가하기위한텍스트

입력박스하나를내보이고자한다. 리스트와텍스트입력컨트롤(뷰)은모두안드로이드

라이브러리를통해사용가능하다. 안드로이드에서사용할수있는뷰와새로운뷰를생성

하는방법에대한보다자세한내용은 4장에서배울것이다.

UI를배치하는데에는레이아웃리소스파일을사용하는방법이선호된다. 그림 2-12와

같이프로젝트의 res/layout 폴더에있는main.xml 레이아웃파일을열자.

그림 2-12

5. 이메인레이아웃을수정하여 LinearLayout에 ListView와 EditText를포함시킨다.

여러분이코드에서이 EditText와 ListView의레퍼런스를얻을수있도록, 이둘모
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두에컨트롤 ID를주는것이중요하다.

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent">

<EditText

android:id="@+id/myEditText"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="새 해야 할 일"

/>

<ListView

android:id="@+id/myListView"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

/>

</LinearLayout>

6. 정의된 사용자 인터페이스와 함께, 여러분의 프로젝트에 있는 소스 폴더에서

ToDoList.java 액티비티클래스를연다. 이번예제에서는 onCreate 메서드를재정

의하는것으로모든변경이끝난다. 먼저 setContentView로여러분의 UI를부풀린

다음, findViewById를사용해 ListView와 EditText의레퍼런스를얻어온다.

public void onCreate(Bundle icicle) {

super.onCreate(icicle);

// 여러분의 뷰를 부풀린다.

setContentView(R.layout.main);

// UI 위젯의 레퍼런스를 얻어온다.

ListView myListView = (ListView)findViewById(R.id.myListView);

final EditText myEditText = (EditText)findViewById(R.id.myEditText);

}

7. 계속해서각각의해야할일들을저장하기위한문자열 ArrayList 하나를정의한다.

ArrayAdapter를 사용하면 ListView를 ArrayList와 묶을 수 있으므로, 새로운

ArrayAdapter인스턴스하나를생성해해야할일들을담기위한배열을 ListView와

묶는다. ArrayAdapter는 5장에서다시살펴보기로하자.
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public void onCreate(Bundle icicle) {

super.onCreate(icicle);

setContentView(R.layout.main);

ListView myListView = (ListView)findViewById(R.id.myListView);

final EditText myEditText = (EditText)findViewById(R.id.myEditText);

// 해야 할 일들을 담기 위한 배열 리스트(array list)를 생성한다.

final ArrayList<String> todoItems = new ArrayList<String>();

// 위 배열을 리스트 뷰와 묶기 위한 배열 어댑터(array adapter)를 생성한다/

final ArrayAdapter<String> aa;

aa = new ArrayAdapter<String>(this,

android.R.layout.simple_list_item_1,

todoItems);

// 위 배열 어댑터를 리스트 뷰와 묶는다.

myListView.setAdapter(aa);

}

8. 이할일목록애플리케이션이기능하게끔만들기위한마지막단계는, 사용자로하여

금새로운해야할일을추가할수있도록하는것이다.“D패드가운데버튼”의클릭

을기다리는 onKeyListener를 EditText에추가한다음, EditText의내용을할일목

록배열에추가하고이변경을 ArrayAdapter에통지한다. 그런뒤 EditText를비워

또다른해야할일이입력될수있도록준비한다.

public void onCreate(Bundle icicle) {

super.onCreate(icicle);

setContentView(R.layout.main);

ListView myListView = (ListView)findViewById(R.id.myListView);

final EditText myEditText = (EditText)findViewById(R.id.myEditText);

final ArrayList<String> todoItems = new ArrayList<String>();

final ArrayAdapter<String> aa;

aa = new ArrayAdapter<String>(this,

android.R.layout.simple_list_item_1,

todoItems);

myListView.setAdapter(aa);

myEditText.setOnKeyListener(new OnKeyListener() {

public boolean onKey(View v, int keyCode, KeyEvent event) {

if (event.getAction() == KeyEvent.ACTION_DOWN)
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if (keyCode == KeyEvent.KEYCODE_DPAD_CENTER)

{

todoItems.add(0, myEditText.getText().toString());

aa.notifyDataSetChanged();

myEditText.setText("");

return true;

}

return false;

}

});

}

9. 이애플리케이션을실행또는디버그하면, 그림 2-13과같이할일목록위에텍스트

입력박스하나가보일것이다.❽

10. 이로써여러분은첫번째“진짜”안드로이드애플리케이션을완성했다. 시험삼아코

드에브레이크포인트를 걸어디버거를테스트해보고 DDMS 퍼스펙티브를 살펴보

자.

현재로서는이할일목록애플리케이션이아주유용하다고는할수없다. 사용자가입력

한해야할일들을세션간에저장하고있지않으며, 목록에있는항목을편집하거나삭제

할수없고, 만기일과작업우선순위같이작업목록에필요한전형적인항목들이기록되거

나출력되지않는다. 모든걸감안해볼때, 지금까지살펴본훌륭한모바일애플리케이션

설계를위한대부분의기준을만족하지못한다.
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역주❽ 그림 2-13과 같은 결과 화면은커녕 컴파일조차 되지 않아 막막해하고 있다면 이유를 곰곰이 한번 생각해보자(힌
트! 자바 소스 파일 맨 앞부분에 보통 나열하는 그것!). 그렇다. 위에서 재정의한 onCreate 메서드는 기존에 없
던 ListView, EditText, ArrayList, ArrayAdapter 등의 새로운 클래스들을 사용하고 있으므로, 소스 파일 앞에
이들에 대한 import 문을 추가해야 한다. ToDoList.java 파일을 열어 아래의 import 문을 추가하자. 혹, 왜 그래
야 하는지 이유를 알 수 없어 고개를 갸우뚱하는 독자들이 있다면, 그림 2-13의 할 일 목록 맨 앞에“자바 배우
기”를 먼저 추가해야 할 것이다.

import java.util.ArrayList;

import android.view.KeyEvent;

import android.view.View;

import android.view.View.OnKeyListener;

import android.widget.ArrayAdapter;

import android.widget.EditText;

import android.widget.ListView;



그림 2-13

이러한부족한부분들은이후의장들을통해수정해나갈것이다.

안드로이드 SDK에는여러분의프로젝트를생성, 테스트, 디버그하기위한여러가지도

구와유틸리티가포함되어있다. 이들개발도구각각에대한자세한설명은이책의범위

를벗어나지만, 어떠한것들을사용할수있는지에대해서는간단히살펴볼만하다. 보다

자세한내용을원한다면아래의주소에있는안드로이드문서를살펴보자.

http://developer.android.com/guide/developing/tools/index.html

앞서말했듯이 ADT 플러그인은이들도구의대부분을이클립스 IDE로편리하게통합

하는데, 아래에나열된것들을포함한이들도구는 DDMS 퍼스펙티브를통해접근할수

있다.

안드로이드 에뮬레이터 여러분이현재개발에사용하고있는컴퓨터상에서실행되도

록만들어진안드로이드가상머신의한구현. 여러분은이에뮬레이터를사용해여

러분의안드로이드애플리케이션을테스트하고디버그할수있다.
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Dalvik 디버그 모니터링 서비스D̀DMS, Dalvik Debug Monitoring Service 여러분의애플리케

이션을디버깅하고있는Dalvik 가상머신을모니터하고제어하려면DDMS 퍼스펙

티브를사용한다.

안드로이드 에셋 패키징 도구ÀAPT, Android Asset Packaging Tool 배포가능한안드로이드

패키지파일(.apk)을생성한다.

안드로이드 디버그 브리지ÀDB, Android Debug Bridge ADB는실행중인에뮬레이터에대

한연결을제공하는클라이언트-서버애플리케이션이다. 이를통해파일을복사하고,

컴파일된애플리케이션패키지(.apk)를설치하며, 셸명령을실행할수있다.

또한아래에있는추가도구역시사용할수있다.

SQLite3 안드로이드에의해생성되고사용되는 SQLite 데이터베이스파일을접근

하는데사용할수있는데이터베이스도구

Traceview 안드로이드애플리케이션의추적로그t̀race logs를보기위한그래픽분

석도구

MkSDCard 에뮬레이터가외부저장카드를시뮬레이션하기위해사용할수있는

SDCard 디스크이미지를생성한다.

dx 자바 .class바이트코드를안드로이드 .dex바이트코드로변환한다.

activityCreator ADT 플러그인없이안드로이드애플리케이션을컴파일하는데

사용할수있는Ant 빌드파일을빌드하는스크립트.

그럼이가운데중요도가높은도구몇가지를좀더자세히살펴보자.

안드로이드에뮬레이터
안드로이드에뮬레이터는여러분의애플리케이션을테스트하고디버그하기위한완벽

한도구로서, 특히테스트를위한실제장비를가지고있지않을경우(또는위험을무릅쓰고

싶지않을경우) 그가치가더욱빛난다.

안드로이드에뮬레이터는Dalvik 가상머신의한구현으로서, 다른안드로이드폰과마

찬가지로안드로이드애플리케이션을실행하기위한유효한플랫폼이다. 어떠한특정하드

웨어와도결부되어있지않기때문에, 여러분의애플리케이션을테스트하는데사용할수

있는훌륭한기준선이된다.
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안드로이드에뮬레이터에는서로다른하드웨어구성을표현하기위해대체해사용할수

있는많은사용자인터페이스가존재하는데, 이들각각은다양한모바일장치종류를시뮬

레이션하기위해서로다른화면크기, 해상도, 방향, 하드웨어기능을가진다.

또한안드로이드에뮬레이터에는애플리케이션을디버깅하는동안인터넷연결속도와

지연속도를조절할수있는기능을갖춘완전한네트워크연결이제공된다. 뿐만아니라

전화와 SMS 메시지의발신및수신을시뮬레이션할수있다.

ADT 플러그인은여러분이프로젝트를실행하거나디버그할때자동으로안드로이드

에뮬레이터가띄워지도록이를이클립스에통합하고있다. 만일 ADT 플러그인을사용하

고있지않거나에뮬레이터를이클립스외부에서사용하고자하는경우에는, 텔넷으로에

뮬레이터에접속해이를콘솔상에서제어할수있다. 에뮬레이터제어에관한보다자세한

사항은 http://developer.android.com/guide/developing/tools/emulator.html에

있는문서를참고하자.

안드로이드 에뮬레이터는 현재 카메라, 진동, LED, 실제 전화 통화, 가속도 센서, USB 연결, 블루투스,

오디오캡쳐, 배터리충전수준, SD 카드삽입/제거등안드로이드가지원하는모든모바일하드웨어기

능을구현하고있지는않다.

Dalvik 디버그모니터서비스(DDMS)
안드로이드에뮬레이터는여러분의애플리케이션이어떤모습으로나타나고, 행동하며,

상호작용하는지를볼수있도록해주지만, 그이면에서일어나는실제적인것을들여다보

려면DDMS가필요하다. Dalvik 디버그모니터링서비스는활성화된프로세스에명령을

보내고, 스택과힙을살펴보며, 활성화된스레드를감시및중단하고, 활성화된모든에뮬

레이터의파일시스템을탐색할수있도록해주는강력한디버깅도구다.

이클립스의 DDMS 퍼스펙티브는이외에도에뮬레이터의화면을캡쳐하고 LogCat이

생성한로그를간단히살펴볼수있는기능을제공한다.

ADT 플러그 인을 사용하고 있는 경우, 이 DDMS는 이클립스 안에 완전 통합되며,

DDMS 퍼스펙티브를통해사용할수있다. 만일ADT 플러그인이나이클립스를사용하고

있지않다면, 명령행을통해DDMS를실행할수있다. 이렇게실행된DDMS는현재실행

중인모든에뮬레이터에자동으로접속할것이다.
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안드로이드디버그브리지(ADB)
안드로이드 디버그 브리지(ADB)는안드로이드에뮬레이터나장치에접속할수있게끔해

주는클라이언트-서버애플리케이션이다. 이는에뮬레이터상에서실행되는데몬, 여러분의

개발하드웨어상에서실행되는서비스, 그리고이서비스를통해데몬과통신하는클라이

언트애플리케이션(DDMS 같은) 이렇게세가지컴포넌트로구성된다.

ADB는여러분의개발하드웨어와안드로이드장치/에뮬레이터간에설치되는통신도

관`導菅으로서, 대상장치에애플리케이션을설치하고, 파일을넣고빼며, 셸명령을실행할

수있게해준다. 이장치셸을사용하면로깅l̀ogging 설정을바꿀수있고, 장치상에사용가

능한 SQLite 데이터베이스를질의또는수정할수있다.

ADT 도구는애플리케이션설치및업데이트, 로그파일, 파일전송(DDMS 퍼스펙티브

를통해) 등흔히있는ADB와의많은상호작용을자동화하고단순화한다.

ADB로 할 수 있는 것에 대해 더 알고 싶다면 http://developer.android.com/

guide/developing/tools/adb.html에있는문서를참고하자.

이번 장에서는 안드로이드 SDK를 다운로드받아 설치하는 방법과 더불어 윈도우, 맥

OS, 리눅스플랫폼에서이클립스를사용해개발환경을구축하는방법그리고여러분의프

로젝트를위한실행및디버그구성을생성하는방법에대해살펴봤다. 여러분은새로운프

로젝트생성을단순화하고개발주기를간소화하기위한ADT 플러그인의설치및사용법

을배웠다.

또한모바일애플리케이션개발을위한몇가지설계고려사항, 특히프로세서속도의증

가보다긴배터리수명과작은크기가더우선시되는경우에있어서의속도및효율성을

위한최적화의중요성에대해살펴봤다.

여느모바일개발이나마찬가지로, 작은화면과더불어느리고비싼데다가신뢰성이떨

어질수있는모바일데이터연결을위한설계시고려해야하는사항들이존재한다.

할일목록애플리케이션을만들고난뒤에는, 여러분의애플리케이션을테스트하고디

버그하기위해사용할안드로이드에뮬레이터와개발자도구에대해살펴봤다.

이번장에서여러분이한일은다음과같다.
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안드로이드 SDK를다운로드받아설치했다.

이클립스에개발환경을설정하고, ADT 플러그인을다운로드받아설치했다.

여러분의첫번째애플리케이션을만들었으며, 이애플리케이션의동작방식

에대해배웠다.

여러분의프로젝트를위한실행및디버그시작구성을설정했다.

안드로이드애플리케이션의종류에대해배웠다.

모바일장치설계고려사항몇가지와구체적인안드로이드디자인프랙티스

몇가지를살펴봤다.

할일목록애플리케이션을만들었다.

안드로이드에뮬레이터와개발자도구를살펴봤다.

다음장에서는액티비티와애플리케이션설계에초점을맞춘다. 여러분은안드로

이드매니페스트를사용해애플리케이션설정을정의하는방법과여러분의UI 레이

아웃및애플리케이션리소스를외부화하는방법에대해배울것이다. 또한안드로

이드애플리케이션의실행주기와상태에관해좀더알게될것이다.
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